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The Challenges

» Build a better JTRS radio than previous legacy set

» Change radio engineers focus from a first generation software integration
problem into one that is focussed on optimising the radio and achieving the
original SCA goals

» SDR infrastructure and in particular the middleware will have to be
improved for the following reasons:

» Enable the radio to be much more highly optimised - smaller latencies,

lower MIPS overhead, reduced power consumption, all of these enabling
longer running, less power hungry smaller form factor sets

» Concerns about heavy weight middleware and SCA infrastructure are
inhibiting the take up of an Open architecture SDR standard in the
commercial space

» More highly optimised middleware will facilitate the adoption of CORBA
running across the radios signal process chain, including DSP and FPGA
architectures

» Improve waveform portability — current waveforms are not very
portable. Key to improving waveforms portability :
» Better tools for building waveforms

» Greater standardization of the software interfaces that integrate the
signal processing chain
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- Optimized Middleware for SDR

1. Optimization considerations for soft radio
designer

2. Anatomy of the GIOP protocol
3. High performance IDL

4. CDR streams and IDL
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CORBA & GIOP

Optimisation considerations for soft-radio designer

vV Vv VvV VvV VvV Vv Vv

Use of CORBA Anys

Use of Anys vs Unions

Use of CORBA structs —typecode concerns
Efficient layout of CORBA structs

Naming methods in CORBA interfaces (GIOP)
Naming objects in the server (OIDs)

Use of Custom Transports
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- CORBA & GIOP

Anatomy of GIOP

» CORBA IDL Interface

Interface |

{
void f();

};
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Example use of CORBA & GIOP

CORBA Request — wire traffic for that simple call void f(void)

/* RequestHeader */

0x00, 0x00, 0x00, 0x00, /Il svc context

0x00, 0x00, 0x00, 0x00, /I request id .
0x01 /l response_expected mi pS
0x09, 0x00, 0x00, 0x00, I/l object key size

0x00, 0x00, 0x00, 0x00, 0x00, /I object key body

0x00, 0x00, 0x00, 0x00,

0x00, 0x00, 0x00, 0x02, /[ operation name size
0x66, 0x00, // operation name ('f' ‘\O'
0x00, 0x00, 0x00, 0x00 /I principal
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CORBA & GIOP

» High Performance IDL - Super optimized marshalling — intelligently
e.g. IDL structure that yields inefficient CDR layout.
® Padding required to align data per CDR rules

struct S {
bool ean T;
| ong U,
char AV
doubl e W
}s

-- sane CDR | ayout as --

void Func(in boolean T, in long U, in char V, in double W;

T u Vv W

A . - A N
o J

v e

Paddi ng Paddi ng

0000000000111 1111111222?2

0123456 789012345¢67890123
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CORBA & GIOP

» CDR streams

IDL structure organization that yields optimal CDR layout.
® Structure elements rearranged to eliminate need for padding.

struct S {

doubl e W
| ong U,
bool ean T;
char V;

};
-- sane CDR |l ayout as --

void Func(in double W in long U, in boolean T, in char V);

w u TV
g A ~ A A
00000D0O0O0OO0OT11 1 1
0123456789012 3
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CORBA & GIOP

» Non optimized allocation and copying of a sequence of structs

® Memory allocation and copying required normally —
inefficient use of ORB

Sequence Object >
max
length
struct S { release (true) /

| ong A; value \9“{‘&
short B; QOQ* “Q@Q } c
| ong C; *\‘5 Q
}; QOQ \6““’0‘ /
OOQ* \‘\6®6‘Q A
t ypedef sequence <S> SS; of
© 5@’&/ } B
\
OQ\; >
© \5\‘\16‘) c
cod
A B C A B C
o L e e Allocated
Memory
Incoming
CDR
~ ~
Padding Padding
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CORBA & GIOP

» Optimized reference to the CDR buffer of a sequence of structs

® To a avoid a costly allocation and copy, the rules for alignment, padding and
endianness of the compiler and processor must all match the corresponding attributes
for the OMG standard CDR rules.

® Fortunately, these rules often do match and the optimization can be applied.

struct S {

long A Sequence Object

short B;

l ong C max
b length
typedef sequence <S> SS; release (false)

value
\
A B C A B C

Incoming
CDR
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CORBA & GIOP

» CORBA in the real-time payload chain

® Operation name ‘TFM’ is optimal for the wire — three characters plus the null
termination character fit nicely into a single DWord of the CDR stream.

IDL: void oneway TFMin DataSeq Data, in Control Seq Control);

| npl ement ati on Pseudo- code:
void TFM Dat aSeq Data, Control Seq Control)
{
/1 Performtransformation on Data either in-place or new copy

TransfornmedDat a = Transforn(Dat a);

pNext -> TFM TransformedData, Control)

}
signal processing chain....
Transformation Transformation Transformation
—P . TFEM . F———TFM——>» . —
Object > Object Object
T|F[M]\O
N g g
Operation Name DataSeq ControlSeq
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CORBA & GIOP

» CORBA in the real-time payload chain

® Operation name ‘TFM’ is optimal for the wire — three characters plus the null
termination character fit nicely into a single DWord of the CDR stream.

IDL: void oneway TFMin DataSeq Data, in Control Seq Control);

| mpl enent ati on Pseudo- code:
void TFM Dat aSeq Data, Control Seq Control)
{
/'l Performtransformation on Data either in-place or new copy

TransformedDat a = Transforn(Dat a) ;

pNext -> TFM TransformedData, Control)

} signal processing chain....
Transformation Transformation Transformation
—T1 . TFM . ——— TFM— .
Object . Object Object >
GPP DSP
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An SCA 3.0 Waveform Model

CONTROL VECTORS
\ 4 v
INPUTS OUTPUT
VECTORS \—> v l VECTORS
/ . I v >
1, g —>— |

Proposed standard interfaces

Any waveform can be modelled as SCA suggests described in IDL — proposed
lightweight CORBA interfaces —

Mod/De ulators

En/De coders

Mux/Demux

Up/down sampler/ Decimators etc

Note control inputs to these blocks are also shown

Note — No hardware mapping is shown — only canonical waveform
described in terms of its signal processing chain and mathematical
operations

SR BN =
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Physical Hardware Mapping

SCA Core Framework and supporting OE

specific particular implementation
= Mapping to this particular physical
modem hardware architecture

Physical
Modem
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|dealized Device Model

Pure canonical signal processing chain of SDR device

Core Framework

POSIX

POSIX

GPP

DSP & FPGA

COTS board

MODEM

transport fabric/RapidlO ..etc
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DSP Device Models

Sgnal processing chain of SDR device

adapters

—> —> I N e >
Core Framework o HAL/MHAL
ORB RTOS
RTOS
GPP DSP
COTS board MODEM
transport fabric/RapidIO ..etc
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DSP Device Models

Sgnal processing chain of SDR device

adapters \ /

*\v Core Framework { / HAL \ﬁ
ORB POSIX \ U
RTOS
GPP DSP
COTS board MODEM
transport fabric/RapidIO ..etc
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FPGA Device Models

Pure canonical signal processing chain of SDR device

Core Framework POSIX Core Framework P
CORBA ORB CORBA ORB
RTOS RTOS
GPP DSP
COTS board MODEM
Switch fabric/RapidIO ..etc
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FPGA Device Models

Pure canonical signal processing chain of SDR device

Core Core Framework POSIX
Framework POSIX CORBA ORB
CORBA ORB RTOS
RTOS Softcore
FPGA adjacent GPP core ] EPGA
Board Board
Switch fabric/RapidIO ..etc
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SCA 3.0 Device Model

Waveform

Core Framework

CORBA

HAL-C
Transport
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PrismTech Proposed Device Model — SCA Machine

CORBA

SCA
Machine <<
GIOP Message Bus RTOS

Sandardized CORBA interfaces enabling SCA machine
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z Why Do We Think It’s Possible ?

» Use of a low MIPS consuming CORBA
Implementation makes possible use of CORBA in
places that were ‘forbidden’ to ORBs before

» The SCA machine idea is in keeping with the
OMGs model of a canonical soft-radio device using
the notion of PIM and PSMs
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Future Benefits

Waveform portability — radically improved
Waveform independence from underlying physical radio topology
Easier to achieve SCA compliance overall

Some degree of independence from waveform language of
implementation

Greater flexibility to optimize and relocate tasks between the
different processor cores underlying.

Greater capability to more flexibly use the shared resource model
proposed by Mercury — re: Mike Kosmicki at the SCA layers.

Increased developer productivity as strict enforcement of the use
of SCA interfaces only everywhere in the radio

Will facilitate easier integration with next generation modelling
tools — providing vastly levels of automatic code generation

Will allow middleware vendors such as PrismTech to supply
much of this technology as COTS —

No need for developers to write custom non portable codecs in
order to support underlying HALs — GIOP used everywhere !
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SDR Accidental Complexities

» Frederick Brooks identified in his article “No Silver Bullet”
» Systems contain inherent and accidental complexities

» Inherent Complexities
» Those found within the problem domain itself
» eg. Modulation, Demodulation, FEC, QoS, ...

» Accidental Complexities

» Those accompanying the production of software but can be
eliminated

» SDR Framework Complexity
» Large number of interfaces
» Difficult to understand how they work together
» Complex implementation technologies (C++, XML, CORBA)
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- SDR Accidental Complexities

» Accidental Complexities (continued)
» Tight coupling to particular vendors/technologies/hardware

» Rediscovery and reinvention of SDR component design
technigues and pattern languages

» Lack of support for re-usability
» Excessive low level details

» E.g.— what exceptions to throw under what
conditions

» Tight coupling between operating elements
» Ie. portability of the implementation
» Lack of tools
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- Eliminating Accidental Complexities

» Elimination of the accidental complexities allows
developers to focus on the inherent complexities — i.e. on
the radio and waveform and not on CORBA and C++

» We need to address these accidental complexities by
leveraging:
» Techniques
» Tools
» Turnkey solutions
» Significantly greater degrees of training
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Techniques

» Separation of Responsibilities and Concerns
» SDR Frameworks purposely separate interfaces
» Allowing waveform development to proceed in parallel to
radio platform development
» Domain Analysis
» Identify commonalities and variabilities of a domain
» Provide re-usable solutions for common aspects
» Provide hooks to allow seamless integration of variabilities

» Support development in the Problem Space vs. the
Solution Space

» Domain Specific Modeling
» Domain Specific Programming
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Benefits of Separation

» SDR users can identify the correct aspect to support
their role
» Waveform Developers
» Radio Platform Developers
» Radio Service Developers

» Testing and Integration is eased
» As coupling is significantly decreased

» When separation is not clearly established
» Users arbitrarily couple the aspects and confuse their roles
» They over-emphasize of one aspect over another
» And here’s an example...

Slide 29 Copyright © PrismTech 2004

Productivity Tools & Middleware



Over-emphasis On Radio Platform
Development

» Many organizations overly concerned themselves
with radio platform development (ie. Core
Frameworks)

» WF developers arbitrarily create a dependency between having a
framework and getting started with development

» WF development can be more complex than radio
platform development

» As the waveform themselves are very complex
» And development needs to start early...

» Even when organizations start WF development early
they provide little to no support for WF developers
» No waveform development tools
» No waveform testing support

» The integration of waveform and platform that follows may require
a some amount of code modification.
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rismTech Approach To Waveform Portability

» Increase overall SDR development productivity via
Graphical development tools

Automatic code generation

High performance middleware

Intuitive SCA Core Framework Technologies (SCA on DSP
and FPGA direct)

» Increased developer training and mentoring to promote
awareness of the issues in SDR — just like the early days of OO
and C++ - we need more awareness campaigns

vV Vv Vv Vv

» Protect past customer investments

» Support/maintenance for existing SW infrastructures and
waveform technology.

» Smooth migration path to future products and standards
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Example - Spectra Modeling Tools

» Graphical Domain Specific Modeling Tool
» Used to Capture Component and Assembly High Level Design
» Provide Constraint Checking
» Correctness checks performed at modeling time vs. runtime
» Automatically generate:

» The source code needed by waveform developers to interface to
the radio platform

» Allow waveform developers to focus on waveform logic
» Not on skeletal infrastructure code
» The descriptors needed by the radio platform infrastructure

» The unit tests needed to test waveform component functionality
and compliance to the platform

» The testing infrastructure to test the waveform stand alone
(without need for the radio platform)

» The high level documentation needed support design
documentation
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PrismTechs Approach To Helping Organizations
Achieve Waveform Portability

» Provide an effective set of waveform modeling tools
» Integration with industry standard tools — e.g. Matlab, Simulink,
ModelSim etc.

» Standards support for different SDR technology bases — e.g for
SCA

» Allows CF::Resource Declaration
» Allows Assembly Declaration and Component Connections

» Automatic Generation of
» CF::Resource Code in C++
» CF:.:Resource Unit Tests
» Surrogate ApplicationFactory capable of deploying Assembly
» Lightweight, Robust, and SCA-compliant
» Supports Waveform Testing
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- Targeting Multiple H/W Environments

» General Purpose Processors
» Digital Signal Processors

» RTL (Resistor Transistor Logic)
» Field Programmable Gate Arrays and ASICs

» Running GIOP protocol between all hardware

» ORBs on GPPs/DSPs and GIOP CODEC on
FPGA
» Within RTL devices, following direction laid
out by upcoming SCA 3.1

» Provide tools for software developers on GPP,
DSP FPGA and ASICs
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Assembly Modeling and Exploring
Deployment Over The Radio’s Topology
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cally Generating The Component Code
and Measuring Test Code Coverage
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Conclusions

CPU optimized CORBA middleware to support components
and effectively push data through the defined interfaces of
the soft-radio model

» Characterized by minimum CPU cycles per KB of data marshalled

» Will enable support for standardized DSP and FPGA interfaces —
increasing waveform portability

Waveform portability requires a multi-level component
architecture regardless of technology mapping used — e.g.
MDA based UML to IDL and SCA or some other model

Tool support is crucial to support an effective and efficient
component architecture with a standards based approach

Waveform synthesis requires care
» keep it in component form — models
» keep it decoupled from the complexities of the underlying platforms
» More emphasis on tools to generate slim, MIPS sensitive code
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